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Introduction

You may have noticed that when you select a different theme in PowerPoint, it rearranges the text on your slides
and adds shapes to the background. This is because each theme has built-in slide layouts and background
graphics. You can edit these layouts with a feature called Slide Master view. Once you learn how to use Slide
Master view, you'll be able to customize your entire slide show with just a few clicks.

Optional: Download our practice presentation.
Watch the video below to learn more about using Slide Master view.

*Video removed from printing pages

What is Slide Master view?

Slide Master view is a special feature in PowerPoint that allows you to quickly modify the slides and slide layouts
in your presentation. From there, you can edit the slide master, which will affect every slide in the presentation.
You can also modify individual slide layouts, which will change any slides using those layouts.

For example, let's say you find a theme you like but you don't like a few of the slide layouts. You could use Slide
Master view to customize the layouts to look exactly the way you want.
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In Slide Master view, the Slide Master tab will appear first on the Ribbon, but you'll
still be able to access commands on different tabs as normal.

Using Slide Master view

Whether you're making significant changes to your slides or just a few small tweaks, Slide Master view can help
you create a consistent, professional presentation without a lot of effort. You could use Slide Master view to
change just about anything in your presentation, but here are some of its most common uses.

* Modify backgrounds: Slide Master view makes it easy to customize the
background for all of your slides at the same time. For example, you could add a
watermark or logo to each slide in your presentation, or you could modify the
background graphics of an existing PowerPoint theme.

* Rearrange placeholders: If you find that you often rearrange the placeholders on
each slide, you can save time by rearranging them in Slide Master view instead.
When you adjust one of the layouts in Slide Master view, all of the slides with that
layout will change.

* Customize text formatting: Instead of changing the text color on each slide
individually, you could use the Slide Master to change the text color on all slides at
once.

* Create unique slide layouts: If you want to create a presentation that looks
different from regular PowerPoint themes, you could use Slide Master view to
create your own layouts. Custom layouts can include your own background
graphics and placeholders.

Some overall presentation changes—like customizing the theme fonts and theme

colors—can be made quickly from the Design tab. Review our lesson on Modifying
Themes to learn more.

To make changes to all slides:

If you want to change something on all slides of your presentation, you can edit the Slide Master. In our example,
we'll add a logo to every slide. If you'd like to work along with our example, right-click the image below and save

Mongibello

Select the View tab, then click the Slide Master command.
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The presentation will switch to Slide Master view, and the Slide Master tab will be
selected on the Ribbon.

In the left navigation pane, scroll up and select the first slide. This is the slide
master.
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Make the desired changes to the slide master. In our example, we’ll insert a
picture of the Mongibello logo.
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Move, resize, or delete slide objects as needed. In our example, we'll resize the
logo and move it to the bottom-right corner.
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When you’re finished, click the Close Master View command on the Slide Master
tab.

.@ o Mongibello Pasta - PowerPoint Picture Tools

Slide Master Home Insert Transitions Animations Review View Format '\; Tell me what you want to

”j \:’ - Delete D Title I:lCoIors' @Background Styles~ IE E

Fontsv Hide Background Graphics

) =} Rename -
Insert Slide Insert = Master Insert Footers | 1hemes - Slide Close
Master  Layout L+ Preserve Layout Placeholder - Effects - Size~  |Master View
Edit Master Master Layout Edit Theme Background il Size Close

The change will appear on all slides of the presentation.
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When you make a change to the slide master, it's a good idea to review your
presentation to see how it affects each slide. You may find that some of your slides
don't look exactly right. On the next page, we'll show you how to fix this by
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Perdand, Mai

DA0-5:00 Tursr-Sun

@) Mongibello

customizing individual slide layouts.

Customizing slide layouts

You can use Slide Master view to modify any slide layout in your presentation. It's easy to make small tweaks like

adjusting background graphics and more significant changes like rearranging or deleting placeholders. Unlike the

slide master, changes to a slide layout will only be applied to slides using that layout in your presentation.

To customize an existing slide layout:

In our example, our newly added logo is hidden behind the photo in the Picture with Caption Layout. We'll

customize this layout to make room for the logo.

Navigate to Slide Master view.
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2 Locate and select the desired layout in the left navigation pane. You can hover the
mouse over each layout to see which slides are currently using that layout in the
presentation.
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Picture with Caption Layout: used bi.r slide(s) 2-3, 5

-----------
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3 In some layouts, the background graphics may be hidden. To show the graphics,
uncheck the box next to Hide Background Graphics.
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4 Add, move, or delete any objects as desired. In our example, we'll delete the gray
background shape.
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Click icon to add picture
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5 If you want to change the arrangement of the placeholders, you can move, resize,
or delete any of them. In our example, we'll move our text placeholders and the
black bar to the right side, and the photo placeholder to the left side.
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5 When you're finished, click the Close Master View command on the Slide Master
tab.
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7 All slides using the layout will be updated.
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Our Team

Owner Shel Rheingold (with Manager Stefan
Linn) leads a talented team with over 30
years of experience making pasta by hand,
crafting unique flavors that tantalize the
palate, and pushing the boundaries of
traditional artisan pasta making.

You can also move placeholders on the slide master, which will move the
placeholders on multiple slide layouts at the same time. However, some slide
layouts may still need to be adjusted manually.

Customizing text formatting

You can also customize the text formatting from Slide Master view, including the font, text size, color, and
alignment. For example, if you wanted to change the font for every title placeholder in your presentation, you
could modify the master title style on the slide master.
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Each title placeholder is connected to the master title style on the slide master. For example, take a look at the
slides before changing the title font.
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Now look at the same slides after changing the title font.
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Instead of customizing individual placeholders, you could change the theme fonts
for a presentation. From the Slide Master tab, click the Fonts command in the
Background group, then select the desired fonts.
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Creating new slide layouts

One of the most powerful features of Slide Master view is the option to create new slide layouts. This is an easy
way to add interesting and unique slide layouts to an existing theme. You could even use this feature to design an
entirely new theme, as in the example below.

Toinsert a new slide layourt:

1 Navigate to Slide Master view. From the Slide Master tab, click the Insert Layout
command.
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The layout will include title and footer placeholders by default. Click the Title and
Footers boxes in the Master Layout group to toggle these placeholders on and off.
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You can now add background graphics, shapes, and pictures to the slide layout.

You can also move, adjust, and delete the existing placeholders. In our example,
we'll move the title placeholder to the bottom-right corner. We've also changed
the text alignment to align right instead of align left.
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Click to ed%t Master title style
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To add new placeholders, click the bottom half of the Insert Placeholder
command, then select the desired placeholder type. In this example, we'll use the
Picture placeholder.
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Click and drag to draw the placeholder on the slide.
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To rename a custom layout:

When you're done designing your custom layout, you'll want to give it a unique name so it will be easy to find.

1 From Slide Master view, select the desired layout, then click the Rename

command.
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| = D Title
Insert Slide Insert H Master Insert Eralas
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Edit Master Master Layout

2 Adialog box will appear. Type the desired name, then click Rename.

Rename Layout 7 X

Layout name:
|Product slide |

| Rename [\‘£| Cancel |

To use a custom layout:

Once you've created a custom slide layout, it's easy to add a new slide with that layout or apply it to an existing

slide.

1 If you're currently in Slide Master view, click the Close Master View command on
the Slide Master tab.

2 From the Home tab, you can insert a new slide with the custom layout or apply it
to an existing slide. In our example, we'll select the Layout command and apply

the new style to slide 6.
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3 The custom slide layout will be applied.

Homemade Gnocchi
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PowerPoint also allows you to add new placeholders to existing slide layouts.
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Using custom layouts in other
presentations

When you modify the slide master or slide layouts in Slide Master view, you're actually creating a custom version
of the current theme. If you want to apply the theme to other presentations, you'll need to save it.

3/20/2018

To save atheme:

From the the Slide Master tab, click the Themes command, then select Save Current Theme from the drop-down

menu.
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If you're not in Slide Master view, you can save the theme from the Design tab. Just click the drop-down arrow in
the Themes group, then select Save Current Theme.
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Challenge!

Open our practice presentation. If you already downloaded our presentation to
follow along with the lesson, be sure to download a fresh copy.
On the slide master, change the Background Style to Style 7.

Delete the tall rectangle shape near the left of the slide master.

Close Slide Master view and select slide 4. Your slide should look like this:
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Let’'s Compare

Them Us

Traditional pasta flavors Unique flavors built on tradition

Conventional use of all-natural dyes; Innovative use of all-natural dyes;
limited color palette wider color palette

Repetitive die-cut process Minimal die-cut process

Reopen Slide Master view. In the Picture with Caption layout, select the
background shape on the left side of the slide behind the text,and change the
color to Dark Aqua.

When you're finished, slide 2 should look like this:

Our Mission

To create unique, high-quality pastas—
made by hand without additives or

preservatives—for individuals who seek
fresh, one-of-a-kind ingredients.

Optional: Save your theme to your computer.
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